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~ What a year we have had. It just couldn't have been much better. Feedback from fishermen -

and women on the re-designed Pantera II, and Eyra has been very positive. Our recessed trolling
motor mount has been added to the ‘96 Classic due to these overwhelming comments of
relieved stress on backs and legs from Pantera and Eyra owners. The new Classic also-has a new
console featuring a built-in Lowrance 1240A. - iy

Then there is one of “our boy's” from Mt. Ida, Arkansas who has. made 1995 a year for the
record books! We just thought our phones have been busy over the years. Mark Davis has been
part of our family since he started competing on the B.A.S.S.® Tournament Trail in 1986 at the
age of twenty-one. In August of 1995 he did what no other angler has done in the 25 year histo- .
ry of B.A.S.S.%, Mark earned the “grand slam” of fishing... 1995 Angler of the Year, and Champion
of the 1995 BASS Masters Classic®. Words can't describe our joy and happiness for Mark, Tilly
and their son James. We've been with him through the tough times, now we want to watch him |
enjoy the good times. He not only earned it... but deserves it. He's one fine fellow!

Many cﬁanges have occurred in the last twenty-five model years since Jan and I started this
company. In 1971, our first boats were built only on custom orders, and we're proud to say
many of those customers are still with us today. Over the years we've grown to become what is
a modest company by basing our primary concern's on quality and value, and continually striv-
ing for perfection in all aspects of manufacturing. Our family business has become one where
our family includes everyone in our operation, as well as, our customers. You can see and feel
the fellowship on the faces of those who attend our “Owners Invitational" each spring.

In this brochure you will see the finest in bass boats available today. Innovative models,

- equipment, and concepts that show Bass Cat Boats has developed these ideas for the serious
angler. Ideas and developments that will make everyone’s day much more enjoyable on the
water... not just bells and whistles, but realistic high quality products. ;

" Every year people ask us what we will do next, or what new models are we working on? We
will always be working on something innovative to the industry, and there will always be new

" models. It is those ideas and developments that have put us on the brink of technology... an

- area we will continue to lead. . :

As is true with the finest of homes and aufomobiles, we build dreams! Dreams of days on the~
water with family and friends. Dreams and memories of the days you will never forget. We
build good solid values and realistic products. It's our way...without gimmicks.
- We would like to be a part of your memories and your dreams. As you look through this
brochure, we urge you'to consider everything from =
safety to comparable products. Most of all we want you
to be happy with whatever product you select and we
welcome the “challenge”...to provide you the best pos-
sible product available. : ¥
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Safe Boating and Good Fishing, '

e

Ron Pierce

" President
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¥ ; ; L Ron & Jan Pierce..founded Bass Cat Boats in 1971,




Quality Craftsmanship at Bass Cat is a family tradition

which is uncompromised. Customer satisfaction, while
continually striving for perfection in our products is the
basis of our success, of which we are very proud.
Hopefully you look for it in every facet of the Bass Cat
Boat. As you look at this “Family Album” of photos
taken throughout the Bass Cat factory, keep in mind
that our boats, trailers, seating, wiring harnesses and
even the embroidety on the Bass Cat seats are made
_from raw materials at Bass Cat, ‘not made for Bass Cat.
When we put the Bass Cat name on our boat, we
know that every facet of the final product meets our
- uncompromising Quality Craftsmansﬁip standards... not
someone else’s. 20




The Margay is a perfect entry level bass
boat for fishermen desiring superb perfor-
mance and hand- ling at a modest price.
When rigged with motors in the 75 to 130
h.p. range the Margay is not only economi-
caf but has great performance, and hand-
" ling, with a stable ride. :

Fishermen will appreciate the dual aerat-
ed rear livewells, comfortable bench seat-
ing, and the over all fishing layout found in
the Margay. And as you can see by review-
ing the standard features, this is not a
stripped down boat...but one with features
found only in “big boats". We feel that even
though you don't require, or desire a “big"
boat, you still expect and deserve this same
“Bass Cat" quality and workmanship found
in our-top of the line boats. ;
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We tecommend you always wear a U.5. Coast Guard Approved Life Jacket anytime your outhoard is running -.with an emergency safety switch attached.

Specifications:
LT P S R |
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Approx. Wt. ..
Fuel Capacity
Max. HP-Range :.. 75-130 H.P,

Standard Features: -
Metal Flake Cap and Insert = Trim Stripe on
Hull » Rope Rub Rail = Bubble Trim »
Carpeted Rod Box = Stalnless Steel Handralls
¢ Carling Switches » Color Coded Wirng =
Bilge Pump « 12/24/36 Bow Panel with 6 Ga.
‘Wire » Custom Pench & (2) Tempress Fold
Down Flshing Seats = VDO -Instrumepts
{Tach, Speed, Volt. Fuel] » ‘Graphics Dash -
Panel » Dual Aerated Livewells = Livewell -
Contral Valve = Ilvewell Flush Valve = PUC.
Enclosed Wiring Harness « Front Trim Switch

. ¢ Deluge Steering Wheel + Two Courtesy

Lights « Horn « Livewell Timer « Trimmed
Floor Edging » Rod Strap = Lockable/Carpeted
Storage Compartments = Built-1n 21 Gal. Fuel
Tafik » Running Lights

Optional Equipment:
» Plexigins Windscreen « Metal Flake Hull

i Silkouette Package (e Trailer) = Ski Tow

Bar = Pro Dutt Seat = Dual Steering *
Recirculating Livewell w/Timer '« Rod Strap »
Lowrance Electronics = MotarGuide 775,
765, 750675, or 665 Trolling Motor = Flush
Mount Controls: OMC, Mercury, Yahama or

. Supukl * Cigarette Lighter = WMaxima

AMTM/Cass Stereo » Custhm Boat Cover

Trailet

*2300 pound Axle » Three (3] Inch Channel
Constpuction » Waterproof Wheel Bearings «
Recessed Waterprool Lights s White Sppke
Wheels » 1200 [b. Winch » Custem Paint and
Matching Carpet + Hote: Ho Spare Tire incl.
Optional Trailer Package:’

= Includes 4" Chanoe! Construction = Spare
Tire * Chrome *“Star® Spoke Wheels
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We ;eﬂo‘mmend you always wear a U.5. Coast Guard Appraved Life Jacket anytime your Uutbna.rd is running.. whh an emergency safety switch attached.

Standard Features::
Metal Flake Cap = Trim Stripe on Hull = Rope
Rub Rail » Bubble Trim » Metal Flake Insert
* Carpeted Floor. Edging » Stainléss Steel
Hardralls = Cm]ing‘ Switches » Front Teim
Switch = 12/24/36 Bow Panel with 6 Ga, Wire
+ Color Coded Wirlng = PVC Enclosed Wiring
Hamess = VDO Instrument Panel (Tach,
,Speed. Volts, Fuel) * Graphics Dash Panel =
Deluxe Stecring Wheel = Circuit Breakers =
' Dual Aerated Livéwells =- Livewell Contral
. Valve » Livewell Flush Valve » (4) Tempress
. Fold Down  Seats » Thiee Seat Fositions *
Twa 13" Seat EXtensions = Passenger
Handrails » Running Lights = Front Light
Switch = Lockable Storage Boxes+ Hydraulic
Lid Openers = Removable Rear Lids = Rear
Cinch Block » Tackle Box Shelf = Master
Switch » Hom » Flush Mount Cleats » Rod
Strap’ = Dual Steefng » LDT 3001 Temp.
Gauge = CMCqu;:[_:tg * Bilge Pump (Auto
ar Man.) = Aerator WiTImer « Twd Courtesy
Lights
Oprtiorial Eqmpmem
* Silkouette Package = Bullt-in Battgrf

Charger /(3] * Pro Batt Seaf * Lowrance

Electronics = Elevated Flipping Deck = * Hyd,

CMC Jackplate = Pro Aeration = ‘Cigarette -

Lighter « MotorGuide 775, 765, 750, 675, or
65 Trolling Mator = 5kl Tow Bar & Ladder =
46 Gal. Fuel Tank « BP100 LCD Digital Dash

~ * Anchor Reing » Moor Mates « Plexiglass

Windscreen» Maxima AMFM/CassStereo =
Custom Boat Cover 3

.

The Caracal is considered the “Hot Rod"“of
the Bass Cat line. The Caracal will outperform,
ercent, wise... per H.P. any boat in the Bass Cat
ine. So, all you fishermen with a few boyhood
actions surfacing every now and then, this is_
the boat for you!

If your not concerned about "hot rodding”,
this boat will still impress 'you. Tournament
fishermen will certainly appreciate the perfor- |
mance, and handling of this* 17’ boat as well as
great fishing decks béth front and rear.
Fisherman will also be impressed with the list
of standard features, from VDO Gauges,
hydraulic lid openers, dual steering, and a
Lowrance 3001 Surface Temperature Gauge to
name a few. -

Specifications: =
eI i ivrieinbisnironcisi 17
Beam .. L BG
Approx. Wt. _..,..........1050 1b.
, Fuel Capacity ............... 27 gal.

Max: H.P. Range'. 115-150 H.P.

b J
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The Sabre may be the “sleeper” of the Bass Cat line.
This 18 boat is a true tournament anglers dream
machine. Anglers will find plenty of storage both with-
in the deck layout as well as under the bench seat. Dual
rear livewells are found behind the bench seat, and the
Sabre comes loaded with standard equipment.

An optional Flippin' Deck as shown is a-welcome
addition to anglers who like to do a lot of flippin’ in the
brush, plus, it allows for added storage space beneath
the decﬂ

A dual console model is also available for those who
enjoy skiing as well as fishing, or simply prefer the
appearance of the dual console Sabre.

* The Sabre ts avaﬂable in *motor combo format for
added value and eqmpplent

3 Specifications:
Length ... e 187
Beam ...... ... 90"
< Approx. Wt. ... 1250 Ib.
= # Fuel Capacity .........c......27 Gal.

Max. H.P. Range ..135-175 H.E.

We-tecommend you always wear a U.5. Coast Guard Approued Life Jacket anytime your uulba:nl is running. swith an =mrg=m:y safety switch attached.

The Sabre shiown with i:'h: Crptional
Elevated Flippin' Déeck.

. Package = Ski Tow Bdr

Standard Features: o

Metal Plake Cap and Insert = Trim Stripe on
Hull » Rope Bump Molding = Bubble Trim «
Carpeted Rod Box = Stalnless Steel Handrails
* Carling Switches « Color Coded Wiring »
Bilge Pump = 12/24/36 Bow Panel With 6 Ga.
Wire » PVC Encloged Wiring  Harness o
Custorn Bench & (2) Tempress-Fold Down
Fishing Scats » Two 13° Beal Extensions =
VDO Instrument Panel (Tach, Speed, Voli, -
Fuel) » Graphics Dash Panel » Bual Aecrated
Livewells® #+ Liyewell Control Valve »

. Lvewel]l Timer = Livewell Flush Valve = Homn

+ Carpetéd Floor Edging « Rod Strap »
Lockable-Storage Compartmients » Running
I..ightl » Front Light Switch = indicator Lights

nt Accessory Switch « Master Switch
Clr:uit Breaker = [PVC ‘Enclosed Wiring
Hamess * Three Seat Positions = Passenger

, Handrail » Rear Cinch Block = Tackle Box

Shelf = Removable Rearfid * Dual Steering «
Hydraulic- Lid C?en!n =" 1240A In-Dash =
]u!: Flate » Flush Mount Cleats

Optlonal Equipment;

« BP100 LCD Digital Dash = Silhouette
s, Skl Ladder =
Plexigiass Windscreen {5td on DC) = Pro Butt )
Sear » Lowrance Electronics = MotorGuide
775, 765, 750, 675, or 665 Trolling Motor = 55
Welded Handrails « Recirculating Livewells
wiTlmer = = Flush Mount Controls: OMC,
Mercury, Yahama or Suruki » 42 Gal. Fuel
Tank  Bullt-In Battery Charger [3) » Flipping
Deck Insert » Pro Aeration » Anchor Relns «
Mooy Mates » Custom Boat Cover -D:I'uxt
Bew Shroud with Lowrance 12404 » M.I:Ln:u
AM/FM/Cass Stereo



We recommend you always wear a [1.5. Coast G-u:lrd Appm\r:d Life Jacket anytime your cutbo:ud Is running.. with an emergency 5afcly Ew'ln:h attached.

Standard Features;

Metal Flake Cap » Trim Stripe on Hull » Rope
Rub Rail » Bubble Trim = Metal Flpke Insert
= Carpeted Floot Edging = Catling Switches »
Frant Trim Switch v 12/24/36 Bow Panel with
6 Ga. Wire = Color Coded Wirng = PVC

" Enclosed Wiring Harness » VDO Instrument

Panel (Tach, Speed. Volt, Fuel] + Graphics
Dash Panel » Lowrance 1240A In-Dash
sDeluxe Steering Wheel » Clecult Breakers »
Dual Aerated Livewells » Livewell Control
Valve = Livewell Timer + Livewell Flush

. Valve = Bilge Pump = (2} Tempress Fold

Down Fishing Seats = Running Lights =
Lockable “Storage Boxes = Hydraullc Lid

Openers » Console Tray = Master Switch «

Hom- » Hod & Ski Strap = Dual Steering »
Cagpeted Storage Boxes » Cigarette Lighter
o' Rod and 5ki Storage » Courtesy Lighting
» Eliding Bucket, Seats (2). Passenger Seat
Also Swivels = AMPFM Cassetts Stereo
Framed Wind Screens '

Optional Equipment:

* Full Top « Side Curtalns = Aft Curtain
Lowrance Electronics » Anchor Reins '}-fz:r
Mates = MotorGuide 775, 765, 750575, or
665 Trolling Motor

= Funghine Package Whith Includes:
Silhouette Package
Ski Ladder
5kl Tow Bar
Maxima Marine 50 Watt AMFMIWE
Casgerte Stereo with 100 Warr Speakars
and Equalizer

The Calico is a very high quality, high performance, “fun boat” designed for the fam-
ily that enjoys skiing, and dpleasure boating, as well as, fishing. A truly sleek
boat...offering exceptional ride and performance with graceful handling characteris-
tics even in rough water conditions. The quality “shines" right up to the optional
Maxima Stereo with 100 watt waterproof speakers.

Most of all we would like for you to compare the quality of hand craftsmanship.
top of the line materials and components including VDO Instrumentation, and the
attention to detail when considering your boat purchase. At Bass Cat our “Families”

: primar%r concern is that
your family has many
yeats of safe, trouble free,
boating pleasure.

e

Specifications:
e D AR 18
Beam ...... e 907
Approx. Wt .....c.e.....£1200 Th.
Fuel Capaclty ..o 39 gal.

Max. H.P. Range.. 115-175 H.P.
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The Eyra represents a new era in eighteen foot bass
boats designed specifically for the serious tournament
angler. A new front deck positions the angler 10-12"
closer to the action with wider deck room. A lowered
foot control platform offers less leg and back stress. This
recessed area, also, is home for bow mounted graphs;
they're out of the way, yet highly visible,

A new console offers even the largest of men leg room
and roomy comfort. A new tilt wheel, seats with high
backs and “wrap around” support help provide addition-
al body control and comfort during rdugh water or long
run situations. Behind the seats you will find a
redesigned extra wide beam with 2000 era styling
which provides added room and good looks to the back
of the ant.- If you fish tournaments with H.P. limita-
tions take a demo ridesin this new Eyra...this is exactly

| el s, L

| e,

.L'I 75 Johes :

A .

what you've always want-
ed... a screamer with a 150, Specifications:
and a layout with features T e L 1711°
you've never dreamed of. Beam .. serserssenueisnnnes 92
Approx. Wt. ..coeveenr. 1350 b
WA F Fuel Capacity .......oonu. 36 Gal.
% Max. H.P. Range ..150-175 H.P.

Standard Features: ’

BP100 LCDr Digital Dash » Metal Flake Cap and Insert + Teim Stripe on Hull = Rope Rub Rail =
Subble Trim + Stainiess Steel Handralls = Carling Switches » Color Coded Wiring » Dual Auto
Bilge Pump » 12/24/36 Bow Fanel with & Ga. Wire « PVC Enclosed Wiring Harness » (2) Tempress
Fold Down Fishing Seats » Dual Aerated Livewells w/ Recirculator » Livewell Flush Valve «
Step-On Trim Switches » Deluxe Mome Steering Wheel = Courtesy. Lights « Horn '« Trimmed
Floor Edging * Rod Straps (2] = Lighted, Lockable, Carpeted Storage Compartments « Running
Lights = Dual Steering with Tt « Front Navigation Switch » ET.A. Circult Breakers = Master
Power Switch » Ice Chest » Battery Check Gauge » Lester Built-In Triple Battery Charger =
Lowrance 1240A In-Dagh = Cpper & Lower Transom Support Plates « ChIC Jackplate

“ Optional Equipment

Silbouette Package » Fro Butt Seat » Lowrance Electronics « MotorGuide 775, 765, 750, 675, or
665 Trolling Motor = Flush Mount Controls: OMC, Mercury, Yabama or Suzuki » Hydraulic CMC
Jackplate » Maxima AM/FM/Cass Stereo » Elevated Flipping Deck # Pro Aération * 1.5 Steering
Wheel Extension = 42 Gal Fuel Tank = Plexiglass Windscreen = Anchor Reins » Moor Mates »
GIL Battery Trays * Custom Boat Cover VDO Gauges; Tach/Speed/VoluFueliQuanz Clock



Standard Feafures: t

Metal Flake Cap = Trim Stripe’on Hull = Rope Rub Rall » Bubble Trim ¢ Metal Flake [nserf «
Carpeted Floor Edging = Carling Switches = Front Trim Switch « 12/724/36 Bow Panel with 6 Ga:
Wire » PVC Encloséd Wiring Harness + Color Coded Wiring » VDO Imstrument Panel [Tach,
Speed, Volts, Fuel) « Graphics Dash Panel « Deluxe Steering Wheel = Clrcuit Breakers = Dual
Aerated Livewells « Livewell Coutrol Valve » Livewsll Timer » Livewell Flush Valve « Bilge
Fump = {2) Tempress Fold Down Fishibg-Seats » Runhing Lights » Lockable/Carpeted Storage
Boxes » Hydraulic Lid Openers » Master Stwitch » Horn « Rod Strap » Dual Steeing « Courtesy
Lights [2) « Stainless Steel Hindralls « Three Seat Floor Positions.s Driver & Passenger
Tempress Bucket Seats » Flush Mount E'Jl!l.tl * Lowrance 1240A » Recessed Trolling Motor Pedal
Optjonal Equipment: 4

Elevated Flipping Deck + Bench Seat » Lester Built-In Triple Battery Charger = Recirculating
Livewell w/Timer + Lowrance Electronics » CMC Jackplate (Man. or Hyd.) » MotorGuide 775,
765, 750, 675, or 665 Trolling Moter = Flush Mount Controls; OMC, Mercury, Yahama, or
Suzuki » Skl Ladder » Ski Tow Bat » Plexiglass Windscreen » Silhouette Package + 55 Weldad
Handrails = Anchor Relns » Moor Mates  Pro Butt Seat.s Pro Aeration » Maxima AM/FMACass
Sterea * Dual Consoles {DC) » Padded Seéating on Rod Box Lids (DC) » GIL Battery Trays »
Custom Boat Cover

We recommend you always wear @ U.5. Coast Guard Approved Life Jacket anytime your outboard is rurning...

with an emergency safety switch attached.

“The Classic features the same 19’ hull design as the Bass
Cat Pantera II, and includes the recessed trolling motor
mount. This design provides the ultimate in ‘big boat”
performance and handling in all types of water condi-
tions, giving you a safe and dry ride. A new console
includes a in-dash Lowrance 1240A. Dual full length rod
boxes and front deck. storage areas to hold all the rods

and tackle needed for a serious day of fishing for you, and-- '

your partner. Additional storage is found under the seats,

-with an ice chest located between the driver and passen-

ger seats. Behind the seats you will find dual aerated,
timed livewells and a deck big enough for your partner to
stretch out and take a nap.

. A Classic dual console (DC) is available for those who
use their boat for both skiing and fishing, or just prefer
the appearance of dual console boats. ;

"TheClassic’s hull design
and overall quality, hand
craftsmanship provide the

g

Specifications:
5T | RS e T [ |

Beam ........ 92" | best overall performance of
Approx. Wt. . 12501b. | any bass boat on the mar-
Approx, Wt, ... 1350 Tb ket...bar none. .

Fuel Capagity ..........c.... 36 gal.

Max. HL.F. Range . 115-200 H.P, *Available in motor combo

format for added value. @

&
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We recommend you always weara U5, Coast Guard Approved Life Jacket amytime yaur outboard 8 running...with an émergency safety switch attached., ‘ vE

Take a close look... new innovative hull and deck designs
abound on the all new Pantera, The New Pantera II is still
the "Rolls Royce" of the Bas$ Cat line, ‘it’s just a newer
“Rolls”. From the eight stringer hull to the BP100 LCD
Digital Dash, the Pantera II is pure perfection in quality,
craftsmanship, and boating innovations which’ puts new
meaning in our tag line...Total Performance Bass Boats.
Years of planning and discussions with professional fisher-
men have produced a new re-designied Pantera II. The new

. bow design places the fisherman 10-12" closer to the

action, while providing 'additional |deck space for a budd
when he feels he's getting “front ended”. This new dec

also features a move of the console to a more forward posi- '
. rough water ride, quality craftsmanship, customer satisfac:

- tion allowing even the largest of anglers ample room and
comfort behind the mew Momo tilt steering wheel. New
comfort is also found in the new bench seats. Higher backs
and wrap around supgmrt provide more comfort

during those long early morning runs. The rear

B section of the new deck of the Pantera II also

finds styling changes: Smoother rounded corners
- . ll .

A

\

N’

are more aerodynamic and allow motor control cabling tc
exit at the center of the splashwell and enter the engine
with4ess binding and kinking as they link the console con:
trol to the engine,

deeper hull on the re-designed Pantera II provides ar
even smoother, no porpoise, rough water ride than the olc
“ hull for which the Pantera has been so noted for through-
out the industry. This new hull.design also allows fo
reduced backwash on shut down.
The Pantera Il DC is available with 'dual consoles. for
those who prefer the looks and added protection from the
elements that they offer their passengers. | -~ .

Compare the standard features, performance, haﬁd[_ing

tion, and reputation of the Bass Cat Pantera II to any bas:
boat on the market...bar none. You will see, regardless o
which Pantera II you .might choose, one thing for sure
...you can't make a bad choice.




Standard Features:

BP100 LCD Digital Dash » Lester Butlt-In Triple
Battery Charger » Lighted Stofage Boxes » CMC
Jackplate * Two Lowrance 12404 (F&R) = Dual
Bllge Pumps [Auto or Man,} » Doal Aerated
Livewells w/ Timers » Livewell Flush Valves «
Graphic Dash Panel s Deluxe Tilt Steering
Wheel + Bubble' Trim = Metal Flake Cap » Trim
Stripe gn Hull « Console Tray wiLighter = Four
Interior Courtesy -Lights' * Livewell Contral
Valve « Circult Breakers » Carpeted .Floor
Edging = Three Seat Foslifons = Two 137 Seat
Extensions »Battery Check Gauge » Front Light
Switch = Carling -Switches » Removable Rear
Lids » Front Accessory Switch = Dual Rear
Livewells.» Rear Cipch Block * Stainless Steel
Handralle = Lockable Storage Boxes = Hydraulls
Lid Openers » Metal Flake Insert » Running
Lights = Tackle Box Shelf = Master Switch »
Indicator Lights » Hom » Four Cléats (Flush
mount) « (2] Tempress Fold Down Fishing Seats
= 12/24/36 Bow Paqel Wi Gauge Wira # Front

Trim Switch » Passenger Handrails « Rod Steap

« Repe Bump Malding + Dual Fuel Tanks « Dual
Steering * FVC Entlosed Wiring Hartiess = Color

Coded Wirng » Mercury Switches » Recessed-

Trolling Motor Petal Basin at Bow

Optional.Equipment:

Dual Consoles * Silhouette Package » Ski
Ladder « Ski Tow Bar » Flush Mount Controls:
OMC, Mercury, Yahama or Suzuki * Pro Butt
Seat » Lawrance Electronics « MotorGuide 775,
765, 750, 675 ot 665 Trolling Motor » Hydraunlic
CMC Jackplate = Elevated Flipping Deck » Pro
Aeration = 55 Welded Handralls » 1.5 Steering
Wheel Extension * Lighted Livewells » Anchor
Relns » Mpor Mates = GIL Battery Trays »
Plexiglass Windscreen = VDO Instruméntation
[Tach, Speed, Volts, Fuel,, Quartz. Clock) = °
Maxima AMFM/Casg Stereo = Custom Boat
Cover ‘

“Beam .
Approx. Weight
Approx. Weight (DC)
Fuel Capacity ....
Max. HL.P. Eange

.52 Gal.
135-200 H.P.




The BP100 LCD Digital Dash
The Bass Cat BP100 LCD Dash

recelved Honorable Mention (2nd
.Place) for marine product innovation
during the 1992 IMTEC's world wide
cormpetition. Yes.. its that good.

Fishermen will be amazed at the
amount of information that can be
retrieved with the touch of'a finger.
The LCD screen |5 driven from a 121{
micro processor thru solid state cir-
cuitry.-This processor is very reliable
and provides you useful informa-
tion,..no gimmicks. You will be
amazed as you review the followi
partlal listing of basic features avail-
able at yuur touch.

Splashwell On Eyra & Pantera Il

)

BP100 Basic Features:

+ LCD Digital Dash Readout » Clock

* Security_System * Trip Odometer
Surface Temperature Readout -«
Barometer = Digital Compass » Trip
Time * Hours » Alr Temperature *
Fuel Gauges (2) * % Engine Efficiency
Gauge » Tachometer » Trim Gauge +
Speedometer = Accessory Swiich =
Programmable Aerators = Qil
Monitor = Voltmeter = Internal
Circuit Protection = Continual
Battery Monitors = Thermal Breakers
» And More

CMC Manual Jackplate

Flippin’ Deck Insert (Optional)

Frant Bow Laynut on the Pantera Classic and Pantera II, the Eyra is
Similar With an Extended Recessed Area to nght of Trolling Mator
Basin for qu Mounted Graphs,

_Perkn Locks




Maxima AM/FM/Cassette (Opt.)

e

Easy Access To Fuel Tanks and Battery Area Dual Rear Aerated Livewells




Most people take the trailer sitting under that shiny
new Bass Cat Boat for granted...but we take our trailers
very seriously. Unlike most manufacturers, Bass Cat
builds: Bass Cat Trailers...one at a time, to fit the specif-
ic hull design of each model boat. Every member and
cross support is jigged, fitted and welded to exact toler-
ances...there is zero adjustment on a Bass Cat Trailer.
Axles are also jigged, and welded in a pattern weld to
assure minimal tire wear from caster to camber. Finally,
each trailer is painted and carpeted to coordinate with
the boat for wﬁich‘i't was built. .

At Bass Cat your safety and the investment you have
made in your boat are not taken for granted..we
demand quality craftsmanship, it's a family tradition,

. Standard Features:

3000 Ib. Axle » Waterproof Bearings = 147 Chrome Wheels » 47 Steel Channel Construction =
1200 |b. Winch = QuI:E Release Crank Jack = Recessed Spare Tire Mount » Fiberglass Color Co-
coardinated Fenders 8 Carpeting » Recessed Waterproof Lights » Polyurethane Enaniel Finish »
Spare Tire « Surge Brakes {Std. on Pantera 1L, Clagsic, Eyra, and Sabre Trailers)

Optional Equipment: 5

Silhouette Aluminum Wheels with Raised White Lettered Goodyear Eagle ST Radial Tires, or
14" Aluminum Mod Wheels with Goodyear Marathon Blackwall Tires «Tandem Axle Traller =
Surge Brakes » Spare Hub and Bearing (Mounted Under Spare Tire] » Remavable Tongue » Clear
Coat Finish {2 Coats Regulred on White Trailers] 3




To Order Please Call+;
Bass Cat Boats = (501) 481-5135
MasterCard and VISA Accepted

The following pages of clothing and accessories have

“been. carefully chosen because of their quality and

value, We hope'you enjoy the items we have deemed
worthy to carry the Bass Cat Logo. 3

The Cumberland by GEAR > $ 89.00
- » Stone washed denim body with khaki sleeves™ Fully lined with

quilted shell » Ribbed Knit Trim » Sizes: S, M, L, XL, XX 1

» Color; Denim with Khaki, Earth and Navy ;

Note: Back embroidery available for additional $10.00

The McKinley by GEAR - : $ 149.00
»Parka-styled outer jacket can be worn alone or with the down-like
poly filled zip out liner *+ Water resistant 100% nylon = Thoughtfully
designed pockets wind flaps, and toncealed hood = Sizes: §, M, L,
XL, XXL = Color: Atlantic w/ Blackberry, Midnight

Note: Back embroidery available for alc-lrgmonal 10.00

: $ 65.00
= 100% soft DuPont® cire nylon shell » 100% polyester batting with
100% nylon lining « 100% acrylic knit collar, cuffs, and watstband »

Sweatshirt Jacket

Zippered front & drawstring hood of soft gray fleece = Slash Pockets
with snap closure » Machine Washable » Sizes: X8, 5, M, L, XL, 2XL,
3XL » Colors: Navy, Red, Black, Maroon, Jade and Grey

= « 100% cotton “Stone Mountain” (laundered denim) shell = 100%

* Office Hotirs: 8:00 a.m. - 4:30 P.M. (CST)
{ Monday thru Friday

* All Items Subject to Availability, and Price
Change. Please Allow 4-6 Weeks for Delivery.

Denim Sweatshirt Jacket -$ 75.00
polyester batting with 100% nylon lining » 100% acrylic knit collar,
cuffs, and waistband » Zippered front with drawstring hood of soft
fleece = Slash pockets » Machine Washable ¢ Sizes: XS, 5, M, L, XL,
2XL, 3XL and 4X, 5X Available for an additional $10.00 = Colors:
Charcoal or Light Blue Denim

The Clipper by GEAR L $ 79.00

= ‘Water-resistant poly/cotton poplin fabric = Caped front, stand-up
collar with contrast gbﬂc lining » Adjustable cuffs » Vented back »
Two ‘way front pockets « Sizes: S M, L, XL, XXL =
Colors:Navy/Green, Sand/Black, and Green/Navy

‘The Victory by GEAR

= Water-resistant 100% nylon taffeta » Super heavyweight .
fleece lining « Elasticized cuffs and waist = Sizes:'S, M, L,
XL, XXL *Colors: Navy, Bottle Green, and Red

Note: Back embroidery available for additional $10.00

$65.00
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Denim Shirt |ﬁ=a5-1n.1i Item.. Call for Availabiliey) $39.95

+ 100% Cotton Denim-+ Two front flapped pockets = Colors: Blue
Denim or NaturalIDentm ¢ Sizes: 5, M, L, XL, ZXL

Pro Shirt -Avail. in Short Sleeves @ $ 32.00,0r Long Sleeves % 35,00

. 65% Polyester/35% Cotton » Button down front * Epaulet’s on
shoulders » Colors: White, Khaki, Red, Teal, Olive, Marcon » Sizes:
5, M, L, XL, 2XL = Specify short or long sleeve when ordering

* Note: Embroidery on collars (Fish Logo and Bass Cat Boats) is offered at an
additional charge of § 5.00, and back embroldered logos are $10.00 per shirt...
Please Specify when ordering. Shirts may vary slightly from photos.

The Falton (shown Abave Left)

» Lightweight 100% Cotton 5 1/20z. washdown cambray » Button
"down collar * Two bufton cuff « Sizes: S, M, L, XL, 2XL, 3XL =
Colors: White; Navy, Red ,

$30.00

The Ventura  (cernter) 1
= Full cut armholes = Woodtone buttons = Longer sleeves = Vented
Rugby tail = 100% Combed cotton interlock * Smooth top-stitching

» Sizes: §, M, L, XL, 2XL, 3XL » Colors; -Navi Red, Roval, Black
Cranberry, Forest, White, Concord, Stone, Graphite, Jade

The Cotton Pigue Color Block (Shewn Above Right $49.00

= 100% Cottoni Pique » Popular Color Block Style = Combination of
three fashionable trim shasl!f combined with color block » Two-but-
ton placket » Horn Buttons » Sizes: §, M, L, XL, XXL » Colors: White
w/ Madroon,Navy, Mushroom. -or- Blackberry w/ Navy, Atlantic
Green, Mushroom -or- Atlantic Green w/ Blackberry, Navy,
Mushroom

=

Tee Shirts White @ § 10,00, Black @ § 12.00

* 100% Cotton = Four color screen imprint on front « Colors: White
or Black » Sizes: 5, M, L, XL, 2XL

§29.95

Bass Cat Embroidered Caps. (One Size Fits All) $7.00

* Polyester/cotton poplin » Color matched bolo cord = Adjustable
tab » Embroidered Bass Cat logo » Colors: Black, Navy, Red, Maroon,
Grey, White, Tan, Hunter Green, Royal Blue

Screen Printed Caps (O Size Fits All) % 4.50

Same Colors ag Above

Custom Embroidered Twill Caps (Above Left} $9.50

» 100% cotton material *+ Adjustable strap s Colors: Jade/Black,
Dusty Rose/Charcoal, Black/Charcoal >

Camouﬂage Embl’ﬂidETEd Caps |Above ;(lg[m ﬂ.ro‘iln: or {_‘;Teen $8.00

Bass Cat "Maniac” Cap $18.50
= Four black cuttcru'fnly twill panels,
two of contrasting color with matching
matching bill"e Two sewn eyelets e
Sideswipe embroidery on front and left
side * Adjustable strap = Color:
Elack/Royal




“To Order Please Call*: ~
Bass Cat Boats = (501) 481-5135

* Office Hours: 8:00 a.m. -4:30 p.m. (CST)
Monday thru Friday

* All Items Subject to Availability, and
Price Change.
Please Allow 4-6 Weeks for Delivery.

MasterCard and VISA Accepted

L *

White Fishin’ Hand Towel $4.50
* 12" x 24" with brass eyelet, and belt
loop clip = Silk screeued logo

TOTAL PERFORMANCE L'ﬂSS Eﬂ.ﬂ .T §
WOUNTAN HOME, ARKANSAS

License Plate $ 5.00

s Brushed Yluminum Bass'Cat fogo set
in a black background -~

Windsuit (shown Above Left)

* Roomy pullover style » Flannel Lining » Hood with -:crdlocks »
Self-Elasticized cuffs » Zippered leg opening » 100% DuPont® soft
nylon fabric Sizes: 5, M, L, XL, 2XL, 3XL » Colors: Navy or Black

Pro-Ranier Rainsuif (shown Above Right) - $149.00 =

* 100% Waterproof PVC Coated Oxford Nylon « All séams are full
taped « Nylon Taffeta lined + Interior Cuff « Two-way fleece line
“cargo pockets » reinforced seat and knees » Sizes: X8, S, M LyXL;

2XL (Note: Jacket sizes run large) s Colors: Hail'y‘ or Red

AL

Custom Mug $5.00
» GlossBlack witha
bright metallic gold
. screened imprint *
Dlﬁh'washe_r Safe
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Hmhie'SunEIasses
., The Shield (shown-Above Left)

 Frame Colors: Black, Blue, Silver, and White = Polarized Triacetate’
Lens Options: Dark Grey or Dark Brown

s $ 4.00
* Colors: White or Red with contrasting trim

$65.00 Embroidered Bass Cat Patches

Size: 4 1/4" x 2 1/4"
i

The Sponsman (shown Above Right)

* Polarized Lens Options: Dark Gtey or Dark Bmwu $ 89.00
* Sightmaster Yellow $ 00.00
» Photochromic Polarized Lens Options: Grey dr Brawn $99.00
The Stdekick-{Hor pictuied, similar to Sportsman) - % 73.00

* Frame Colors: Matte_Black or Brown = P-::Iarlzed Triacetate Lens
Options Browh m’ Grey

Bass Cat Brass Belt
Buckle $15.00

* Solid Brass with an
embossed Bass Cat
Logo and Bass Cat
Boat, Size: 2 3/4" x 2*

Wlndt:lw Decal’s
Small (Left Bottom) $1.50°

- Medium (Left Ctr) $10.00

Large (Bottom) $20.00
* High quality pressure
sensitive reflective decal
with Bass Cat Logo
Colors: White letters with
red” trim or red letters
with white trim = Large
decal has tag line...Total
R;:zfurmance Bass Boats =
Sizes: Small (4 1/4" x 17),
Medium '(19' x 4 1/27),

Large (27" x 67)



Every year we look forward to our “Family Reunion”...
The Bass Cat Invitational on Lake Norfork. We call this
a family reunion because it's one time each year that all
Bass Cat owners (our family) are invited to Mountain
Home, Arkansas for some good ole Ozarks hospitality.

Our only goal is to show our sincere appreciation to our,

family of Bass Cat owners.
The two day Invitational begins with registration on
* Friday evening. Saturday morning is truly a sight to
behoE:L as the sun peeks over'the mountains, your heart
starts pounding a little faster as the daylight reveals a
bay with little lights dancing all around on the water.
It's not often that you see such a spectacle as 600-800
Bass Cat Boats staged for a tournament takeoff. It is an
-overwhelming sight to behold.
" The Bass Cat Invitational is a family affair. We provide
an atmosphere for family participation with Rubber
Duck Hunts, Kids' Contests, and even an event for the
wives who aren't fishing. =
Following the first day's weigh-in contestants get a lit-

getting ready for the evening festivities. The festivities
include... a real honest to goodness Ozarks Barbecue and
an evening of fun with friends...totally alcohol free.
After everyone is so filled they feel like their little bel-
'lies will pop, we provide a few drawings for prizes. The
final drawing which has included a new Bass Cat boat

and trailer...not many leave early! i

Sunday morning brings the ffnal 'day of competition
and some serious thinking, and wondering if any of
those fish stories heard the night before had any truth
to them. The afternoon's final day weigh-in provides a
little computer printout that makes several folks really
appreciate this “Family Reunion”. One thing for sure,
even if you don't win one of those diamond rings for
“Big Bass" honors, nor one of the boat and trailer rigs for
catching a mess of fish...you still receive a few days of
memories which you will always cherish. We promise
you one thing, on the way home you will look forward

tle time to relax, and swap a few fish fish stories before

to the next Bass Cat “Family Reunion”.
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Bags Cat Boats warrants to the original purchaser, each new boat or trailer used for noncommercial uses, to be free from defects in workmanship and material for a peri-
od of two (2} years under normal conditions of recommended use, with a five (5) year hull warranty under the same conditions: :

Ta validate this warmanty, the bodt registration card must be-retumned to Bass Cat Boats within fifteen (15) days after original purchase. All boat manufacturers re
required by Federal law to:notify first purchasers in the event any defect is discovered “which creates a substantial risk of personal l"I.'”)' to the public”, or any non-
compllance by manufacturer. The failure of any purchaser tp fill out and return the warranty registration card may make It impossible for Bass Cat Boats to give direct
Totice to such purchaser. J k- '
DmJn&th.L: two-year period, any authorized warranty repairs will be made free of charge by Bass Cat Bbats at their manufacturing plant in Mountaln Homie, Arkansas,
orat their option, by an quthorized Bass'Cat Boats boat dealer at the dealer’s store ar service center. Transportation costs to the factory ase the responsibility of the pur-
chaser, All warranty repairs must be approved by Bass Cat personnel, whose decisions are final. r S ;
This warranty does not apply to (1] any boat which shall have been repaired or altered in any way so as to affect its use and operation; (2} gelcoat cracking, crazing, blis-
tering. or discoloring: (3) windshield breakage; (4) any boat which has been subJu:t to misuse, negligence or accident, ar used for racing or commercial purposes or oper-
ated contrary to any printed instructions Furnished by Bass Cat Boas, (5) u}:hu siery damage: (6) accessories, steering systems, pumps, lights, and other equipment not
manufactured by Bass Cat Eoats {these are covered by warranties (If any) of the respective manuficturers supplying these ltems and are not covered under this lim{ted
warmmanty); {7} any boat which has been overpowered according to the maximum recommended engine horsepower specified on the capacity platg affixed to the boat.
This warranty is ﬂﬂrﬂﬂf in leu of all ather warrantles. express or lmplied, including any tmplied warranty of merchantability or fitness for-a particular purpese; and
In lieu of all other obligations or Labilities on the ]l’uan of Bass Cat Boats, and Bass Cat Boats expressly.denies on the part of any person to Ingur or assume for It any other
lability in connection with the sale or use of its boats and trallers. Implied warranties; if any, given by valid law shall be limited to the'duration of this writtel war-
ranty. S i P, . “

The obligation of Bass Cat Boats, under this warrinty, shall be limited to.the repair'or replacement of any parc which s Eudged defective by Bass.Cat, Boats. Bass Cat Boats
will not be liable for haul-out, launching, towing or storage charges, inconyenience or loss of time o Income, or any other special or consequéntial damages of any kind
or nature. / . . £

The informarion in this literature is based upon the latest product information available at the time of publication approval. Bass Cat Boats reserves the right to make
changes anytime, without notice, In the colors, equipmeat, specifications, materlals, hulls, prices, m?m discontinue models. When changes are made, we reserve the
right to do 50 without incurring the obligations to equip or modify existing models built prior ta the date of such changes. \ -

— Colbrols Paskss

The Elusive
and, Slam!

Help celebrate Mark Davis' never before attain- ' o
| able feat of any angler earning the B.A.5.5." Angler~ *° -
of the Year title and Classic® all in the same year. i ol
Total Performance Bass Boals O This Limited Edition PDID—S['S'IE Shirt (50% combed
Cotton/50% Polyester), and new "Maniac” Cap set are

available for only.. $39'9 5




Mark Davis has earned not only the prestigious title of “1995 B.A.S.S.® Angler of the
Year”, but was also crowned Champion of the 1995 BASS Masters Classic®”. Quite a
feat...a feat no other angler has achieved in the 25 years of B.A.S.5.® Classic history.

- / .
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Total Performance Bass Boats

P.O. Drawer 1360 * Mountain Home, Arkansas 72653 « (501) 481-5135




